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- corresponde a sua op¢ao de cargo.
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VOCEDEVE:

- procurar,na FOLHA DE RESPOSTAS, o nimero da questao que voceé esta respondendo.
- verificarno caderno de prova qual a letra (A,B,C,D,E) da resposta que vocé escolheu.

- marcaressa letrana FOLHA DE RESPOSTAS, conforme o exemplo: ® @ © © ®

ATENCAO

- Marque as respostas primeiro a lapis e depois cubra com caneta esferografica de tinta preta.

- Marque apenas uma letra para cada questao, mais de uma letra assinalada implicara anulagido dessa questdo.
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- Proibida adivulgacdo ou impressao parcial ou total da presente prova. Direitos Reservados.
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CONHECIMENTOS BASICOS

As questdes de numeros 1 a 10 baseiam-se no
texto apresentado abaixo.

Atencéo:

Nem o cientista mais ortodoxo pode negar que mexer
com equacdes é dificil e cansativo. Mas a ciéncia nédo deixa de
ser bonita ou agradavel apenas por causa disso. A arte, apesar
de bela, também néo é facil: todo profissional sabe a dor e a
delicia de aprender bem um instrumento ou de dominar o pincel
com graca e precisdo. E verdade que dificilmente alguém
espera encontrar numa equagdo ou num axioma as qualidades
proprias da arte, como a harmonia, a sensibilidade e a ele-
gancia.

A graga e a beleza das teorias, no entanto, sempre
tiveram admiradores — e hoje mais do que nunca, a julgar pela
guantidade de livros recentes cujo tema central é a sedugédo e o
encanto dos conceitos cientificos. Exagero?

“As leis da fisica sdo em grande parte determinadas por
principios estéticos”, afirma o astronomo americano Mario Livio,
do Telescopio Espacial Hubble, também autor de um livro em
que analisa a nocdo de beleza dentro da ciéncia. Ele afirma
que, quando a estética surgiu na Antiglidade, os conceitos de
beleza e de verdade eram sindnimos. Para ele, o traco de uniéo
entre arte e ciéncia reside exatamente nesse ponto. “As duas
representam tentativas de compreender o mundo e de organizar
fatos de acordo com uma certa ordem. Em dltima instancia,
buscam uma idéia fundamental que possa servir de base para
sua explicacdo da realidade.”

Mas, se o critério estético é tdo importante para o pen-
samento cientifico, como ele se manifesta no dia-a-dia dos
pesquisadores? O diretor do Instituto de Arte de Chicago acha
gue sabe a resposta. “Ciéncia e arte se sobrepdem natural-
mente. Ambas sdo meios de investigagdo, envolvem idéias,
teorias e hipdteses que séo testadas em locais onde a mente e
a mao andam juntas: o laboratério e o estudio”, afirma.

Acredita-se que as descobertas cientificas sirvam de
inspiracdo para os artistas, e as obras de arte ajudem a alargar
0 horizonte cultural dos cientistas. Na pratica, essa mistura gera
infinitas possibilidades. A celebragdo que artistas buscam hoje
ja ocorreu diversas vezes no passado, de maneira mais ou
menos espetacular. Na Renascenga, a descoberta da
perspectiva pelos gedmetras encantou os pintores, que logo
abandonaram as cenas sem profundidade do periodo classico e
passaram a explorar sensag¢fes tridimensionais em seus
quadros. Os arquitetos também procuravam dar as igrejas um
desenho geometricamente perfeito; acreditavam, com isso, que
criavam um portal para o mundo metafisico das idéias

religiosas.

No século XX, essa tendéncia voltou a crescer. A grande
preocupacdo dos pintores impressionistas com a luz, por
exemplo, tem muito a ver com as conquistas da Otica. A
matematica também teria influenciado a pintura do russo
Wassily Kandinsky, segundo o qual “tudo pode ser retratado por
uma férmula matematica”. Seu colega Paul Klee achou um jeito
de colocar em varios quadros alguma referéncia as progressoes
geométricas. Bem-humorado, brincava com as idéias da mate-
matica dizendo que “uma linha é um ponto que saiu para
passear”.

(Adaptado de Flavio Dieguez. Superinteressante, junho de
2003, p. 50 a 54)

1.  E correto afirmar que no texto se encontra uma

(A) defesa da ciéncia como base para o desenvolvi-
mento da arte, que depende de alguns principios
estabelecidos por aquela, para desenvolver-se
satisfatoriamente.

(B) analise de aspectos comuns a ciéncia e a arte, com
o intuito de apontar semelhangas e reciprocidades
entre uma e outra, cada qual com seus principios e
objetivos.

(C) |ustificativa do predominio da arte sobre os principios
cientificos, pois ha evidéncias de ter ela surgido
muito antes, como manifestacdo do pensamento
humano.

(D) apreciagdo, de certo modo desfavoravel, de algumas
teorias cientificas que buscam explicar as fontes de
inspiracdo das obras de arte, no decorrer da Historia.

(E) avaliacdo, voltada para alguns principios aceitos por
artistas, de que a ciéncia deve muito de seu
progresso as descobertas e solugfes adotadas por
pintores em todas as épocas.

2. Exagero? (final do 2° paragrafo)

A resposta correta a indagagdo acima encontra-se na
opinido de que

(A) os métodos utilizados, tanto por cientistas quanto
por artistas, séo bastante semelhantes entre si.

(B) as teorias cientificas se valorizam tanto mais quanto
mais se aproximam das teorias que envolvem as
manifestacdes artisticas.

(C) a arte se sobrepbe a ciéncia, com as inumeras
possibilidades experimentais que surgem nos estudios.

(D) os laboratérios cientificos buscam sempre a verda-
de, enquanto as producgdes artisticas se voltam para
a beleza.

(E) a ambiguidade existente na definicdo dos conceitos
de arte e de ciéncia vem desde a Antigliidade.

2
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Para ele, o traco de unido entre arte e ciéncia reside
exatamente nesse ponto. (3° paragrafo)

A expressao grifada indica, considerando-se o contexto,

(A) a busca por uma proposta que fundamentasse as
possiveis explicages para a realidade.

(B) os métodos que podem chegar aos mesmos
resultados, quer na arte, quer na ciéncia.

(C) a percepgdo de que a pesquisa cientifica é arida e
cansativa, assim como a preparagdo de uma obra de
arte.

(D) o idéntico sentido que sempre se atribuiu aos
conceitos, tanto de beleza quanto de verdade.

(E) as teorias cientificas que tentaram explicar a har-
monia e a beleza das obras de arte.

Considere as afirmativas que se fazem a respeito do
emprego de sinais de pontuagao no texto:

I . O travessédo que inicia 0 segmento — e hoje mais do
que nunca (2° paragrafo) — assinala uma pausa
maior no periodo, como énfase para a afirmativa
introduzida por ele.

I'l. As aspas, que abrem e fecham o segmento “As
duas representam tentativas ... para sua explicacao
da realidade.” (3° paragrafo), indicam reproducéo
exata das palavras de um escritor.

I'l'l. Os dois-pontos em - ... andam juntas: o laboratério
e o0 estudio ... (4% paragrafo) - introduzem um
segmento enumerativo.

Esta correto o que se afirma em
(A) |, somente.

(B) |11, somente.

(C) | ell,somente.

(D) |1 elll,somente.

€ 1,11elll.

A substituicdo da expressdo grifada por um pronome
correspondente esta INCORRETA em:

(A) ou de dominar o pincel = de dominé-lo.

(B) analisa a nogdo de beleza = a analisa.

(C) buscam uma idéia fundamental = buscam-lhe.

(D) envolvem idéias, teorias e hipéteses = envolvem-nas.

(E) teriainfluenciado a pintura = té-la-ia influenciado.

6. Na pratica, essa mistura gera infinitas possibilidades.
(5° paragrafo)
O verbo que exige o mesmo tipo de complemento que o
do grifado acima esté na frase:
(A) A arte, apesar de bela, também néo é facil ...
(B) ... quando a estética surgiu na Antiglidade ...
(C) ... o traco de unido entre arte e ciéncia reside
exatamente nesse ponto.
(D) .. que logo abandonaram as cenas sem profundidade
do periodo cléassico ...
(E) Bem-humorado, brincava com as idéias da
matematica ...
7. ... acreditavam, com isso, que criavam um portal para o
mundo metafisico das idéias religiosas. (5° paragrafo)
Os verbos grifados acima, considerando-se o tempo e o
modo em que se encontram, indicam, no contexto,
(A) processo em decurso permanente no passado.
(B) acéo realizada em um tempo determinado, no
passado.
(C) probabilidade de realizagdo de um fato qualquer.
(D) situagdo transcorrida no passado, anterior a outra,
também passada.
(E) condig&o essencial para a realizagdo de um fato.
8. ... que as descobertas cientificas sirvam de inspiragdo

para os artistas ... (5° paragrafo)

O verbo que se encontra nos mesmos tempo e modo do
grifado acima esta na frase:

(A) Mas a ciéncia ndo deixa de ser bonita ou agradavel
apenas por causa disso.

(B) Em Jdltima instancia, buscam uma idéia funda-

mental ...

(C) ... que possa servir de base para sua explicacdo da
realidade.

(D) ... como ele se manifesta no dia-a-dia dos

pesquisadores?

(E) .. que logo abandonaram as
profundidade do periodo cléssico ...

cenas sem
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9. A concordancia verbo-nominal esta inteiramente correta 11. Com relagdo aos sistemas operacionais, considere:
na frase:
| . Conjunto de programas que gerenciam 0S recursos
(A) Segundo alguns cientistas, as mais brilhantes do computador.
formulas da fisica ou da biologia € comparavel ao
que de melhor foi feito na literatura do século XX. I'l. Conjunto de editores de textos e de planihas
eletronicas para automacao comercial.
(B) O principio da economia aproxima a poesia, com
seu inigualavel poder de sintese, das equacgfes I'1'1. Conjunto de programas que faz a interface entre o
matematicas, que resumem grande quantidade de usuario e o computador.
informagdes.
(C) Nem sempre as informacdes que se encontra E correto o que se afirma APENAS em:
disponivel para um cientista pode orientad-lo na
busca de solugbes para o problema que tentam A .
resolver. B lell.
©C lelll.
(D) Cientistas, em toda a Histéria, defende a idéia de D) I1.
que tanto a estética cientifica quanto a artistica se (E) III.
caracteriza pela busca da ordem em seu mais alto
rau.
’ 12. Na Internet, um conjunto de paginas e de arquivos de um
(E) A emocédo é um dos ingredientes mais importantes . . | . .
da estética cientifica, embora se pensem que deve servidor é chamada de ..°... , que é acessado atravées de
estar distantes dos objetivos dos pesquisadores. um software conhecido como .!l.. ea primeira pagina a
10. Os cientistas esforgam-se por mostrar que existe arte por ser acessada, normalmente recebe o nome de L
trés das equacges. Preenchem correta e respectivamente as lacunas | , | |
Artistas contemporaneos procuram aproximar-se da P !
ciéncia. .
. . elll:
Observa-se um esforco reciproco na tentativa de recuperar
uma antiga férmula da filosofia grega. . .
Na filosof?a grega, beleza é iguagll a?/erdade () Web, Link e S'te.
! ' (B) link, Web e pagina HTML
As frases acima articulam-se em um Unico periodo, com (C) site, navegador e home page
clareza, correcdo e l6gica, da seguinte maneira: (D) home page, browser e site
(E) pagina HTML, navegador e home page.
(A) Os cientistas esforgam-se por mostrar que existe
arte por tras das equagbes, do modo como artistas
contemporaneos procuram aproximar-se da ciéncia, 13. Quanto aos direitos e garantias fundamentais previstos na
observando-se um esforgo reciproco na tentativa de Constituicao Federal, é INCORRETO afirmar que
recuperar uma antiga férmula da filosofia grega: de
cuja a beleza € igual a verdade. (A) ninguém podera ser compelido a associar-se ou a
permanecer associado.
(B) Na filosofia grega beleza é igual a verdade, pois os . , , . .
cientistas esforcam-se por mostrar que existe arte (B) ninguém sera obrigado a fazer ou deixar de fazer
por tras das equacdes; de que os artistas alguma coisa sendo em virtude de lei.
contemporaneos procuram aproximar-se da ciéncia, (C) a propriedade atendera a sua fungso social.
€ observado um esforco reciproco na tentativa de
recuperar-se essa antiga férmula da filosofia grega. (D) aleinao retroagira, salvo para prejudicar o réu.
(E) é assegurado a todos o acesso a informacédo e
(C) Artistas contemporaneos procuram aproximar-se da resguardado o sigilo da fonte, quando necessario ao
ciéncia, desde quando os cientistas esforcam-se por exercicio profissional.
mostrar que existe arte por tras das equacgées;
observa-se um esforgo reciproco que tenta recuperar
uma antiga férmula da filosofia grega, a formula da 14. Em tema de Direitos Politicos € CORRETO afirmar que
beleza verdadeira.
(A) ndo podem alistar-se como eleitores o0s estrangeiros
(D) Os cientistas esforcam-se por mostrar que existe e, durante o periodo do servigo militar, os conscritos.
arte por tras das equagdes; artistas contemporaneos
procuram aproximar-se da ciéncia, onde observa-se (B) sao elegiveis os inalistaveis e os analfabetos.
um esforgco reciproco, o qual tenta recuperar uma
antiga formula da filosofia grega: beleza é igual a (C) aidade minima para concorrer ao cargo de Prefeito
verdade. é de dezoito anos.
(E) Observa-se um esforgo reciproco na tentativa de (D) o alistamento e o voto séo obrigatérios para maiores
recuperar uma antiga férmula da filosofia grega, segundo de dezesseis e menores de dezoito anos.
a qual beleza é igual a verdade: os cientistas
esforgam-se por mostrar que existe arte por tras das (E) para concorrer a outros cargos o Presidente da
equacles, enquanto artistas contemporaneos procuram Republica deve renunciar ao respectivo mandato até
aproximar-se da ciéncia. trinta dias antes do pleito.
4 TREPB-Conhecimentos-Basicos*
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15. Considere: 18. A Administragdo Publica que desejar comprar ou alienar
bens iméveis, em regra, podera contratar por meio de
| . A composicdo dos Tribunais Eleitorais é hibrida, licitagdo na modalidade
integrando juizes de outros tribunais federais e o
estaduais, juristas da classe dos advogados e (A) concorréncia.
membros do Ministério Publico.
(B) pregéo.
I'l. Os juizes dos tribunais eleitorais, salvo motivo
justificado, servirdo por dois anos no minimo, e (C) tomada de precos.
nunca por mais de dois biénios consecutivos, sendo
0s substitutos escolhidos na mesma ocasifo e pelo (D) concurso.
mesmo processo e em numero igual para cada
categoria. (E) convite.

I'1'l. As Juntas Eleitorais serdo compostas por 2 ou 4 19. Adénis foi nomeado técnico judiciario no Tribunal Regional
membros, 0s quais, por elei¢éo e pelo voto secreto, Eleitoral de certo Estado membro. Nesse caso, dentre 0s
escolherdo seu presidente. requisitos béasicos para a investidura de Adénis nesse

cargo é a aptidao fisica e mental, que devera ser

A respeito da composicdo dos érgdos da Justica Eleitoral, demonstrada mediante

é correto o que se afirma APENAS em

(A) um atestado médico, de cada aptiddo, oficiais ou

A I, ndo, antes de sua posse.

® I11l.

(B) inspec¢do médica oficial depois da posse, mas antes
de sua entrada em exercicio.

© lell.

©) Ilelll. (C) inspecdo medica oficial realizada antes de sua

posse.

E) lelll.

(D) dois atestados médicos oficiais, apresentados
16. Quatro candidatos disputaram a eleicdo de Governador do durante seu estagio probatério.

Estado. O mais votado, antes de realizado o segundo

turno, renunciou a sua candidatura. Nesse caso,

(E) inspegdo médica, oficial ou ndo, no inicio de seu

(A) o segundo turno serd disputado entre o segundo estagio probatdrio.

colocado e o candidato a Vice-Governador do que
renunciou.
20. Analise:
(B) o segundo turno serd disputado entre o segundo
colocado e, dentre os remanescentes, o mais idoso.
| . O Executivo, Legislativo e Judiciario da Uniéo sdo

(C) néo sera realizado segundo turno e a renincia do considerados autoridades.

mais votado implicara na convocacdo de novas
eleicoes. 1. A unidade de atuagdo dotada de personalidade
juridica é considerada entidade.

(D) o partido politico a que pertencia 0 renunciante

devera indicar substituto para disputar o segundo I'l'l. Considera-se ¢rgéo a unidade de atuacdo inte-
turno com o segundo colocado. grante da estrutura da Administracdo direta e da
estrutura da Administracao indireta.

(E) o segundo turno serad disputado entre o segundo

colocado e, dentre os remanescentes, o de maior
votacao. Para os fins da Lei n®9.784/99, que regulamenta o
processo administrativo no ambito da Administracéo Publi-
ca Federal, esta correta APENAS as afirmacdes de
17. O conceito de que a Administracdo Publica deve agir de

modo rapido e preciso com o fim de produzir resultados
que satisfagam as necessidades da populacdo, diz
respeito ao principio da

(A) impessoalidade.
(B) eficiéncia.

(C) legalidade.

(D) continuidade.

(E) moralidade.

A 1.
® lell.

© lelll.
©) Il.

€ Ilelll.

TREPB-Conhecimentos-Basicos*
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CONHECIMENTOS ESPECIFICOS

21. Considere a a janela representada abaixo.

Ela é do tipo

(A) guilhotina.

(B) projetante.

(C) pivotante horizontal.
(D) pivotante vertical.
(E) correr.

Atencéo:

Para responder as questées de nimeros 23 e 24,
considere a planta do pavimento abaixo.

— T
2%5 e
“IC 6

torago

suite

banheiro

terrago

22. Um lote de terreno retangular medido em planta com
régua comum (simples), apresentou as medidas da figura.

6 cm

4 cm

Sabendo-se que o desenho esta na escala de 1:500, a area
do lote, em m?, é de

()

(B)

©

(D)

(E)

240

480

600

960

1200

23. Os elementos @ e @ s&o, respectivamente,
(A) ventilagBes e torneiras.
(B) shafts e chuveiros.
(C) caixas de inspecéo e registros.
(D) armarios embutidos e chuveiros.
(E) gaveteiros para roupa suja e torneiras.
24. Os elementos @, @ e (® representam, respectivamente,
(A) sofd, criado-mudo e cama.
(B) cama, cadeira e sofa.
(C) penteadeira, banco e cama.
(D) armario embutido, criado-mudo e cama.
(E) cama simples, banco e cama dupla.
25. Observe os simbolos abaixo.
—==— ¢ —i|—
Eles representam, respectivamente,
(A) luva e unido.
(B) torneira de bdia e ralo.
(C) hidrdmetro e juncdo com derivante para cima.
(D) uni&o e cruzeta.
(E) tubo reto horizontal e tubo de queda.
26. Parareceber a agua dos vasos sanitarios é recomendavel

o uso de

(A)
(B)
(©
(D)
(E)

ralos simples.

ralos sifonados.

caixas de passagem.

desconectores ou sifées (caixas sifonadas).

caixa de inspec¢éo.

TREPB-Tec.Jud-Edificagfes-Y23
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27. Observe os simbolos abaixo. 30. Ao iniciar-se a construgcdo de um edificio escolar em uma
cidade do interior em terreno retangular de 50 x 40 m, em
loteamento novo com apenas a demarcagao dos lotes, é
@ ' @_‘ e %:‘ necessario demarcar o lote para a instalacéo do canteiro.
A trena fornece os lados, enquanto os angulos sé&o
Eles representam, respectivamente, determinados por triangulago.
_ ) ) 50,00
(A) interruptor paralelo, interruptor simples e ponto de AN — o
luz. SO P S
N 7 <
\\\ ///
(B) quadro de distribuicdo, ponto de luz na parede e S o e
disjuntor. PN
(C) tomada 127V 2P+T média, tomada 127V 2P+T alta e 7 Sl
ponto 220V bifasico alto. e SN
D) interruptor simples, quadro de distribuicdo e . . ) .
©) condut%r P q ¢ As diagonais 1 e 2 devem medir, em metros, respectivamente
' e aproximadamente,
(E) tomada 127V 2P+T baixa, tomada 127V 2P+T média (A) 64662
e ponto 220V bifasico médio. (B) 64e64
(C) 50e55
i . (D) 50e50
28. Observe a figura abaixo. (E) 45¢ 45
N \ Atencdo: Para responder as questdes de numeros 31 e 32
| considere a figura que representa uma forma de
20 4 concreto.
il
L1 L2 L3 V2
h=8 h=8 h=8
L4
V4
Ela representa: L
5 — W e L7
(A) elevacio. h=8 h=8 h=g escada
(&) ~ e (2] \9!
> L > > > >
(B) depresséo. V5 L ~
(C) espigéo. 31. Com relagao as vigas,
(D) garganta. (A) V1 é semi-invertida e V3 é normal (direta).
(B) V3 éinvertida e V5 é normal (direta).
(E) vertente. (C) V6 e V8 sao semi-invertidas.
(D) V6 e V8 sao normais (diretas).
(E) Todas sdo normais (diretas).
29. Considere a convencao topogréfica abaixo.

Ela representa:

(A) via acompanhada de linha telefénica.

(B) via acompanhada de linha telegréfica.

(C) estrada de ferro.
(D) estrada de rodagem dupla.

(E) tdnel de estrada de ferro.

32. Com relagéo as lajes,

(A)
(B)
(©)
(D)
(E)

todas sdo rebaixadas.
todas sdo pré-moldadas.
L3 é rebaixada.

L1 é rebaixada.
somente L4 é macica.

33. Numa mistura de concreto feito na obra, o tragco é

1:2,5:3,5 em volume e o consumo de cimento é de
300 Kg/m3. A quantidade aproximada em litros de areia e
de pedra, respectivamente, para um saco de cimento é:

(A) 175 e 125 Dados:

(B) 126 e 90 1 saco de cimento = 36 litros
(C) 125 e 175

(D) 100 e 150

(E) 90 e 126

TREPB-Tec.Jud-Edificagfes-Y23
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Atencdo: Considere a figura abaixo para responder as 38. A caracteristica do meio fisico ambiental que mais
guestbes de nimeros 34 e 35. influencia em uma construgéo é
B
A (A) égua.
(B) solo.
terreno
(C) ar.
construcao
(D) sol.
E lima.
3 A (E) clima
D
c Ruaw 39. Salas de aula devem ter insolagao

34. O afastamento ou recuo lateral minimo para abertura de (A) nos dias frios.

portas e janelas, deve ser, em metros, de
(B) de manha.

(A) 1,00 (C) de tarde.
(B) 1,50 (D) nos dias quentes.
(€) 180 (E) em todo o periodo.
(D) 2,00
(E) 2,50

40. Num ambiente litoraneo é desejavel que o sol bata nos

35. O recuo de frente em relagéo ao meio fio da rua deve ser comodos de permanéncia noturna no periodo

medido a partir

(A) datarde.
(A) de C até o prolongamento de 3-4.
(B) do ponto 3 e perpendicular ao alinhamento. (B) todo.
(C) do ponto médio entre 3-4 e perpendicular a reta 3-4. (C) da manha.
(D) do ponto 4 e perpendicular ao alinhamento. (D) de inverno.
(E) do ponto médio de C-D até o ponto médio de 3-4.

(E) de veréo.

36. Os codigos de obra dos Municipios classificam os compar-
timentos de uma edificagdo conforme sua destinacdo. Os o 5 L
destinados a atividades escolares s&o considerados de 41. Com relacdo as escavacdes para a realizacdo de obras de
permanéncia fundagGes em uma construcdo € INCORRETO:

(A) prolongada. (A) dispor de escadas ou rampas quando sua profun-

(B) especial. didade for superior a 1,25 m.

(C) transitoria.

D) fixa (B) escavagfes até 2,00 m de profundidade podem, em
o geral, ser executadas sem especial seguranga com

(E) mista. paredes verticais.

37. Em caso de reformas e adaptacdes as rampas de (C) depositar os materiais retirados a uma distancia
circulacdo de uso comum ou coletivo devem ter largura ngtZIr:Jodrea metade da profundidade, a partir da borda
minima, em metros, e declividade maxima, em %, res- ’
pectivamente, de

(D) todas as escavacdes que devem ser pisadas por
(A) 1,00 e 11 pessoas, precisam dispor de um espaco de trabalho
(B) 1,20 e 15 > 0,50 m de largura.
(C) 1,30 e 10

(E) prever, para trabalhos em valas para condutos e
(D) 120 e 125 canais, onde ha trafego de pessoas, largura livre de
(E) 1,70 e 15 0,60 m para diametros < 0,40 m.
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42.

O detalhe adequado para a amarracdo de duas paredes
de blocos ceramicos ou de concreto, que evita a trinca
vertical, é:

L

chapisco

o

/
) g
|

argamassa
de cimento e areia

/
®) g
|

uma barra
de aco a cada 2 fiadas

]

(©) Z <

]

/

duas barras
de aco a cada 2 fiadas
/! /

e ]

(D) 7 g

]

/

uma barra
de aco a cada 2 fiadas

/

]

() - <

]

/

—L

43. Apobs a execucgdo das paredes internas, o azulejo deve ser
aplicado sobre as mesmas no prazo de
(A) 1dia.
(B) 2 dias.
(C) <4dias.
(D) 6dias.
(E) =8dias.
44. A espessura da camada de argamassa de assentamento
de azulejos sobre paredes internas deve ser, em cm, de
A) =<2
B) >3
(C) =4
(D) <5
(E) =6
45. Para receber tinta fresca sobre massa corrida, as paredes
e pecas de concreto devem ser preparadas seqien-
cialmente com:
(A) massa grossa, chapisco e massa fina.
(B) selante, massa grossa e massa fina.
(C) chapisco, massa grossa e massa fina.
(D) massa grossa, selante e massa fina.
(E) selante, chapisco e massa fina.
46. Com relacéo aos tipos e sistemas de impermeabilizacéo, é

INCORRETO afirmar:

(A) Emulsées de polimeros originalmente rigidos
(acrilicos, acetato de polivinil etc) ndo sédo recomen-
dados para areas externas de climas equatoriais ou
semi-equatoriais.

(B) Sistemas rigidos sdo recomendados para grandes
areas sujeitas a grandes sobrecargas.

(C) O nimero minimo de camadas de feltro asféltico
coladas entre si com asfalto é de trés.

(D) O sistema de multimembranas asfalticas é reco-
mendado para estruturas contra dgua de subpressao
e de percolacéo.

(E) Toda impermeabilizagdo deve ter sua superficie pro-
tegida contra esfor¢cos mecénicos.
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47. A figura abaixo mostra uma laje de cobertura corretamente 49. Em um canteiro de obra onde estdo previstos 30
impermeabilizada e isolada termicamente. trabalhadores, devem estar previstos, pelo menos:
© @ ©®
\ Sanitarios Chuveiros
120 08 B o, o 812005 08 00 0%, 5,8 02 850 8 Se0 08| A 4 5
B 3 4
C 2 3
D 1 2
E 1 1
Os elementos @, @, ® e @ representam,
respectivamente, o ) )
50. Quanto aos mictérios instalados em canteiro de obra é
1 2 3 2 INCORRETO afirmar que eles devem
. camada = pedra brita
isolamento . . protecao
A térmico impermeabi- mecanica ou individuai leti
lizante pedregulho (A) ser individuais ou coletivos.
pintura camada =
concreto . . . . prote(;ao
B maaro impermeabi- | impermeabili- mecanica . . I . .
g lizante zante (B) ter revestimento interno de material liso, impermea-
12 argamassa| camada a vel e lavavel.
. .| 2% camada de .
C de impermeabi- reqularizacio pedra brita
regularizacao lizante 9 & .
isolamento cortina de protegao (C) ser providos de descarga.
D P . Al pedregulho
termico vacuo mecanica
camada pasta de concreto de ) . .
E | amortecedora cimento regularizacio pedregulho (D) ficar a uma altura maxima de 0,50 m do piso.
48. A figura abaixo representa um painel de alvenaria de bloco (E) ser ligados, obrigatoriamente, & rede pblica.

de concreto de 14 x 39 x 19 cm.

\\/\\\ 51. Com o comando line acionado e o units no modo default
60 520 o | do Autocad 2004, o comando @25<60 desenhara uma
linha de vinte e cinco
S
R 1 : 1 : 1 : 1 : 1 : 1 : 1 : 1 : 1 : 1 : 1 : 1 : (A) metros de comprimento na inclinacdo de sessenta
I graus.
janela
2 g . .
® (B) metros de comprimento numa inclinagdo menor que
| sessenta graus.
B [ T 1 [ T 11 [ T1
3 [ T T T T T T T T T T
- 2 D N N R B (C) centimetros de comprimento na inclinagdo de
~ sessenta graus.
160 1 200 l 160
1 1
i \\/\\—\_ (D) centimetros de comprimento numa inclinagdo menor
gue sessenta graus.
=
;TL (E) graus com sessenta metros de comprimento.
52. Para criar um novo estilo de dimens@es no Autocad 2004,
0 caminho correto é
Desenhos sem escala
. : 4 2
(@] nimero de blocos cons:umldos e q area, em m<, para (A) Dimension>New>Dimension Style.
efeito de pagamento de mao-de-obra €, respectivamente,
(A) 195 e 15,6 Obs.: (B) Dimension>Format>Dimension Style >New.
— considerar a espessura da arga-
(B) 170 e 14,6 massa de assentamento igual a
lcm; (C) Format>Dimension Style >New.
(C) 120 e 116 — considerar critérios normalmente

usados para efeito de medic&o.

(D) 145 e 136 (D) Draw>Dimension Style>New.

(E) 100 e 10,6 (E) Draw>New>Dimension Style.
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53. A funcdo dos comandos Stretch, Fillet, e Offset no
Autocad 2004 é, respectivamente:

(A)

(B)

©

D)

(E)

Alongar um objeto, linha ou poli-linha; Unir duas
linhas (ou poli-linhas) perpendiculares informando o
raio do angulo a ser adotado; Copiar apenas linhas
paralelamente informando a distancia entre a original
e a copia.

Alongar um objeto, linha ou poli-linha; Unir duas
linhas (ou poli-linhas) perpendiculares informando o
raio do angulo a ser adotado; Copiar linhas ou poli-
linhas paralelamente informando a distancia entre a
original e a copia.

Alongar um objeto, linha ou poli-linha; Unir duas li-
nhas (ou poli-linhas) perpendiculares através de uma
terceira linha com comprimento a ser determinado;
Copiar linhas ou poli-linhas paralelamente infor-
mando a distancia entre a original e a copia.

Estender uma linha ou poli-linha até outro objeto,
linha ou poli-linha; Unir duas linhas perpendiculares
informando o raio do angulo a ser adotado; Copiar
linhas ou poli-linhas paralelamente informando a
distancia entre a original e a copia.

Estender uma linha ou poli-linha até outro objeto,
linha ou poli-linha; Unir duas linhas ou poli-linhas
perpendiculares através de uma terceira linha com
comprimento a ser determinado; Copiar apenas
linhas paralelamente informando a distancia entre a
original e a copia.

56.

No que concerne as licitagdes, € INCORRETO afirmar:

(A)

(B)

©

(D)

(E)

Segundo o principio da adjudicacdo compulséria, a
Administracdo Publica é obrigada a contratar
imediatamente com o licitante vencedor.

O julgamento das propostas deve ser objetivo e
pautado por critérios claros contidos no edital.

Quanto a competicdo no processo licitatorio, pode-
se afirmar que é relativa, na medida em que, no
interesse publico, impde-se regras, dentre outras,
que afastam licitante ndo constituido regularmente.

No convite pode-se dizer que a publicidade é
mitigada, pois ndo se exige maior divulgacéo, sendo
reservada a competicdo aos licitantes convidados.

Sao modalidades de licitagdo a concorréncia, a
tomada de pregos, o convite, o concurso, o leildo e o
pregéo.

54. Em relag&o ao Autocad 2004, considere:

O Autocad é um software baseado em coordenadas
X, ¥, z e w, sendo que estas coordenadas
determinam se os desenhos serdo em 2D e/ou 3D.

Os chamados comandos de atalho ndo podem ser
modificados, pois o autocad ndo oferece opg¢bes
para esta funcao.

Na opcdo Options do menu Tools, o autocad
oferece ao usuario a opgdo para que 0 arquivo
guando salvo seja em versdes anteriores a utilizada
ou em .dwf.

E correto o que se afirma em:

(A)
(B)
©
©)
(E)

| , apenas.

| ell,apenas.
I, 11 elll.

Il elll,apenas.

I I'l,apenas.

57.

No caso em que todos os licitantes forem inabilitados ou
todas as propostas forem desclassificadas, a administra-
¢ao podera fixar aos licitantes o prazo de

(A)

(B)

(©)

(D)

(E)

dez dias (teis para a apresentacdo de nova docu-
mentagao ou de outras propostas, facultada, no caso
de convite, a redugdo deste prazo para cinco dias
Uteis.

cinco dias Uteis para a apresentacdo de nova docu-
mentagao ou de outras propostas, facultada, no caso
de convite, a redugdo deste prazo para trés dias
Uteis.

trés dias (teis para a apresentagdo de nova docu-
mentacdo ou de outras propostas, em todas as
modalidades de licitago.

oito dias Uteis para a apresentacdo de nova do-
cumentacdo ou de outras propostas, facultada, no
caso de convite, a reducdo deste prazo para trés
dias Uteis.

quinze dias Uteis para a apresentagdo de nova
documentagdo ou de outras propostas, facultada, no
caso de convite, a reducdo deste prazo para cinco
dias uteis.

55. Um quadrado no Autocad 2004 é desenhado através de

(A)
(B)
©

©)
(E)

linha simples ou poli-linha, apenas.
linha simples, poli-linha ou através do menu Insert.

linha simples, poli-inha ou através do comando
Retangle.

linha simples, poli-linha ou através do menu Draw.

poli-linha, apenas.

58.

A respeito da habilitacdo no processo

licitatério, a

inscricdo do ato constitutivo, no caso de sociedades civis,
acompanhada de prova da diretoria que se encontra em
exercicio, € documentagao relativa a

(A)

(B)

©

(D)
(E)

qualificacéo técnica.
habilitacdo juridica.
qualificacdo econdmica.
regularidade fiscal.

habilitagdo de responsabilidade financeira.
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59.

Nos termos da Lei n® 8.666/93, é correto 0 que consta
APENAS em:

()

(B)

©

©)

(E)

O contratado fica obrigado a aceitar, nas mesmas
condic¢des contratuais, 0s acréscimos ou supressées
que se fizerem nas compras, até cinquenta por
cento do valor inicial atualizado do contrato.

Quando ocorrer caso fortuito impeditivo da execucao
do contrato, havera rescisdo contratual e, inde-
pendentemente da culpa do contratado, serd ele
ressarcido dos prejuizos demonstrados.

Em regra, o prazo é de cento e vinte dias para
observacéo ou vistoria comprovadora da adequagao
do objeto aos termos do contrato administrativo.

Se houver agente publico nomeado para fiscalizar o
cumprimento do contrato, é facultado ao contratado
manter preposto no local da obra ou servi¢o, para
representa-lo na execugéo do contrato.

A Administracdo Publica responde solidariamente
com o contratado pelos encargos previdenciarios
resultantes da execug¢do do contrato, nos termos da
legislagao especifica.

60.

Tendo em vista as disposicGes da Lei n<28.666/93,
considere:

Os contratos administrativos regulam-se pelas suas
clausulas e pelos preceitos de direito publico,
aplicando-se-lhes, supletivamente, os principios da
teoria geral dos contratos e as disposi¢bes de
direito privado.

A garantia do contrato administrativo, cujas
modalidades s&o, dentre outras, caugdo em
dinheiro e fianga bancaria, sempre sera exigida
pela Administra¢éo no patamar de dez por cento do
valor contratado.

As clausulas econdmico-financeiras e monetarias
dos contratos administrativos poderéo ser alteradas
sem prévia concordancia do contratado.

Nao se admite contrato com prazo de vigéncia
indeterminado, sendo admissivel a prorrogacéao,
desde que justificada por escrito e previamente
autorizada pela autoridade competente.

E correto o que consta APENAS em:

(A)

(B)

©

(D)

(E)

lelll.

Il elll.

I elV.

I, elV.

1,11 el
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